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Designer This guide is intended to help you create and manage OLAP universes based on SAP BW data sources. The universes can be used in Web
Intelligence, Dashboard and Analytics, Live Office, and Query as a Web Service.
An OLAP universe is a Business Objects universe that has been generated from an OLAP cube or query. The universe is created automatically from a selected
connection to an OLAP data source. You generate and maintain an OLAP universe in the following way: · · To generate an OLAP universe, first select the
SAP BW data source. Define a connection to the data source using the New Connection wizard, and select the connection for a new universe. Designer
generates the universe automatically.
OLAP structures are mapped directly to classes, measures, dimensions, details, and filters in the universe. The universe structure appears in the Universe
pane. · · · You can save and export the OLAP universe to the CMS. You can modify any of the OLAP universe components. The Update OLAP Universe wizard
allows you manage the lifecycle of the OLAP universe. The wizard automatically refreshes the universe structure with changes made in the OLAP data
source. The wizard can differentiate generated objects from objects added or modified manually, allowing you to preserve the manual changes made in
Designer. Note: This guide sometimes refers to other OLAP data sources, or OLAP data sources in general. In these cases, the information applies equally to
SAP BW data sources. Related Topics · · · · · · Prerequisites to using SAP BW in Universe Designer on page 7 SAP BW data sources on page 9 Defining a
connection to an SAP BW data source on page 15 Designer features supported for OLAP universes on page 26 OLAP universe lifecycle management on page

35 How SAP BW objects are mapped and used in a universe on page 39 6 Using SAP BW in Universe Designer Prerequisites to using SAP BW in Universe
Designer 2 2 Prerequisites to using SAP BW in Universe Designer When creating a universe from an SAP BW data source, you can enable SSO (Single Sign
On) for view time.
SSO allows users to log on to BusinessObjects Enterprise with their SAP Credentials and leverage SAP Authentication. To enable SSO for OLAP Universes
on top of SAP, you must install the SAP Integration and configure the SAP Security Plug In. Once SAP security integration is configured, you can use SAP
credentials to launch Designer. Create the BusinessObjects Enterprise user name by concatenating the SAP System ID and SAP Client ID as defined when
configuring the security integration with the SAP user ID. For more information, see the Business Objects XI Integration for SAP Solutions Installation
Guide, and the Business Objects XI Integration for SAP Solutions User Guide. 8 Using SAP BW in Universe Designer SAP BW data sources 3 3 SAP BW data
sources SAP BW InfoCubes as data sources When creating an OLAP universe based on an SAP BW (Business Warehouse) data source, you can build the
universe based directly on an InfoCube/MultiCube, or based on a BW Query enabled on top of any InfoProvider. An InfoProvider can be: · · · · an InfoCube a
MultiCube or Multi-InfoProvider an Operational Data Store (ODS) an InfoSet Related Topics · · · SAP BW InfoCubes as data sources on page 10 SAP BW
Queries as data sources on page 11 SAP BW Queries as recommended data sources on page 12 SAP BW InfoCubes as data sources The following types of
InfoCubes are supported as data sources for building OLAP universes: · · Standard and Transactional InfoCubes: Data and metadata are physically stored in
the same SAP BW system Remote InfoCube: Data is physically stored on a remote system Note: While fully supported, building and deploying universes on
remote InfoCubes is not recommended for ad-hoc query-, reporting-, and analysis-use scenarios. Such architecture is generally not expected to meet query
performance expectations with interactive queries. · MultiCubes and Multi-InfoProviders Note: Building and deploying a Business Objects universe on top of
a MultiCube or Multi-InfoProvider is identical to building and deploying a universe on top of an InfoCube. All the characteristics, hierarchies, key figures,
including time and unit, in the InfoCube are visible in the universe.
10 Using SAP BW in Universe Designer SAP BW data sources SAP BW Queries as data sources 3 SAP BW Queries as data sources SAP BW customers use
BW Queries to access SAP Business Explorer front-ends.
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Note: In order to serve as a data source and become available through the OLAP interface to Business Objects universes, BW queries must be released for
OLE DB for OLAP. You allow external access to the BW Query in the SAP BW Query Designer, on the Extended tab of the Query Properties dialog box. All
InfoObjects in the BW query selected as rows, columns, and free characteristics are visible in the universe. @@Both InfoSets and Operational Data Stores
(ODS) can be exposed to universes via BW Queries.
BW Queries based on an ODS An ODS can be exposed to a universe via a BW Query. ODS objects are often used to manage detailed transaction-level data
before it is aggregated into InfoCubes. Including ODS objects in the BW data store design is a way to minimize InfoCube size and improve loading and
querying performance. Note: An ODS is usually a large, detailed relational structure. Accessing an ODS via the OLAP BAPI interface does not deliver ideal
query performance.
Consider these alternatives to meet end-user expectations for fast report delivery: · · Create direct access to an ODS via BAPI calls Access the ODS tables
using direct SQL in Web Intelligence BW Queries based on an InfoSet An InfoSet can be exposed to a universe via a BW Query. InfoSets are sometimes
defined in SAP BW to report master data. Using SAP BW in Universe Designer 11 3 SAP BW data sources SAP BW Queries as recommended data sources
Note: You can report master data by basing the universes on InfoCubes, eliminating the requirement to go through InfoSets and BW Queries. The key
difference between the two approaches is that master data reported off InfoCubes limits data to valid transactions. Related Topics · SAP BW Queries as
recommended data sources on page 12 SAP BW Queries as recommended data sources BW Queries are recommended as data sources for generating
Business Objects universes for the following reasons: · Not all BW metadata features can be retrieved on an InfoCube level, as summarized in the following
table. SAP BW metadata feature SAP OLAP BAPI support level Characteristics (incl. Time and Unit) InfoCube/BW Query Hierarchies Basic Key Figures
Navigational Attributes Display Attributes Calculated Key Figures / Formulas Restricted Key Figures Custom Structures Variables InfoCube/BW Query
InfoCube/BW Query BW Query only InfoCube/BW Query BW Query only BW Query only BW Query only BW Query only · BW Queries offer a flexible
extension to the data modeling environment. InfoCubes require more effort to change. 12 Using SAP BW in Universe Designer SAP BW data sources SAP BW
multilingual universes 3 · BW Queries offer significant functionality to create customized data sources that meet end-user requirements. Although BW Queries
have advantages as data sources, you do not need a BW Query for every report, nor do you need a universe for every existing BW Query.
To minimize maintenance costs, focus the implementation strategy on limiting the final number of BW Queries and universes required to meet all the ad-hoc
query and reporting needs. Keep in mind the following points to reduce the number of universes needed: · · When Web Intelligence is the frontile > New,
select Tools > Options. On the "General" page of the "Options" dialog box, select the File/New starts Quick Design wizard check box. Click OK and select
File > New. Tools menu Select Tools > Connections. Click Add... in the "Wizard Connection" dialog box. To select database middleware for an OLAP
connection On the "Database Middleware Selection" page of the New Connection wizard, enter a name for the connection, select the type and the database
middleware for the connection.
Using SAP BW in Universe Designer 17 4 Defining a connection to an SAP BW data source To define login parameters for SAP BW connections Database
Middleware Selection parameter Connection Type Description Select Secured for controlled access to the connection (recommended). Select Shared to allow
uncontrolled access to the connection to all users. Select Personal to restrict access to the universe creator. You can use personal connections to access
personal data on a local machine only. Connection Name Enter a name for the connection.
Filter Stored ProceThe Filter Stored Procedures Network Layers padures Network Layers rameter is not used for OLAP connections. List of available data
acThe page lists the databases and middleware that cess drivers. correspond to your data access driver key. Expand the node for your target database to
show the supported middleware for that database. Expand the middleware node to show the Business Objects data access driver for the OLAP middleware.
Select the data access driver. To define login parameters for SAP BW connections On the "Login Parameters" page of the New Connection wizard, specify the
login details for connecting to the SAP BW database. 18 Using SAP BW in Universe Designer Defining a connection to an SAP BW data source To define
login parameters for SAP BW connections 4 Login parameter Description Select Use Single Sign On when refreshing reports at view time to allow the user to
benefit from SAP SSO. Authentication mode Select Use specified username and password to require the user to enter login information when using the
connection. Select Use BusinessObjects credential mapping to use the user's BusinessObjects Enterprise login credentials for the connection. User name
Enter the SAP User logon. Enter the SAP User password. Enter the SAP client number (required). Enter the connection language, for example EN for English
(required). Password Client Language Note: The connection language determines the language in which the universe is generated.
Select Application server to connect directly to the SAP server without using load balancing. Login mode Select Message server to benefit from SAP load
balancing capabilities. Select or enter the name or IP address of the SAP application server (required for Application server login mode). Application Server
Using SAP BW in Universe Designer 19 4 Defining a connection to an SAP BW data source To select source cube or query for OLAP connections Login
parameter Description System Number Enter the system number, for example 00 (required for Application server login mode) . System ID Logon Group
Message Server Enter the System ID , Logon Group, and Message Server parameters (required for Message server login mode). To select source cube or
query for OLAP connections The cube browser shows the OLAP cubes available to the target server. Expand the cube nodes to display the cubes and queries
available. The browser has the following tools to help you search: Cube browser tool Description Favorites A folder that holds links to cubes that you select
for quick access.
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To add a cube to Favorites, right click a cube in the OLAP cube browser and select Add to Favorites from the contextual menu. Searches the names of
available cubes or queries for a text string.
Type a string in the text box and click Search. Each found instance is highlighted. Click Search to continue searching. Search 20 Using SAP BW in Universe
Designer Defining a connection to an SAP BW data source To define configuration parameters for OLAP connections 4 Cube browser tool Description
$INFOCUBE folder For SAP BW data sources, the InfoCubes and MultiCubes are grouped in a folder called $INFOCUBE. Select the cube or query to use to
create the universe.
To define configuration parameters for OLAP connections On the "Configuration Parameters" page of the New Connection wizard, define the connection
parameters to manage the connection life-time. You can accept the default settings when you create the connection and modify them later. Using SAP BW in
Universe Designer 21 4 Defining a connection to an SAP BW data source To define configuration parameters for OLAP connections Configuration parameter
Connection Pool Mode Description You define the life-time with the Connection Pool Mode and Pool timeout parameters. By default, the Connection Pool
Mode is set to Keep the connection alive for, with a default Pool timeout of 10 minutes. Note: Business Objects recommends you keep the default connection
life-time.
The universe building process slows significantly if the Connection Pool Mode is set to disconnect after each transaction. Disconnecting after each
transaction also impacts key end-user workflows such as working with hierarchical list of values. The connection life-time can have a significant impact when
working with SAP BW. Pool timeout However, connection life-time can also impact updating existing universes with changes in the BW Query. This is
because the OLAP BAPI interface builds a metadata cache on the client side every time a connection to BW is established. This cache is only emptied when
the connection closes. To minimize the risk of metadata cache being desynchronized with SAP BW Query updates, you can change the Pool timeout from 10
minutes to 1 minute. When working in parallel editing SAP BW Queries and mapping new universes to these queries, it is recommended that you close
Designer (so that universe connections are also closed and the metadata cache is emptied) before building any new universes to take into account changes
that were just made on the SAP BW Query side. 22 Using SAP BW in Universe Designer Defining a connection to an SAP BW data source To define
configuration parameters for OLAP connections 4 Configuration parameter Array fetch size Array bind size Login timeout Description The Array fetch size,
Array bind size, and Login timeout parameters are not used for OLAP connections. Using SAP BW in Universe Designer 23 4 Defining a connection to an
SAP BW data source To define configuration parameters for OLAP connections 24 Using SAP BW in Universe Designer Customizing OLAP universes 5 5
Customizing OLAP universes Designer features supported for OLAP universes Designer features supported for OLAP universes OLAP universes are created
automatically.
Once you have created the OLAP universe, you can modify any of the universe components. These Designer features are supported for generated OLAP
universes: · · · · · · · · · · · · · Hide, duplicate, and rename classes and objects (dimension, detail, and measure) Insert new classes and objects (dimension,
detail, and measure) Edit an object's format Edit an object's data type Define primary and foreign keys Parse dimension, detail, and measure object MDX
syntaxes Check universe integrity Edit hierarchies Create cascading list of values Define a delegate search for a list of values, allowing users to limit loading
of the list of values at query run time Use default values for variables Define measures with database delegated projection function (smart measures) Refresh
the universe structure In addition, the following features are available uniquely for OLAP universes: · · · Create calculated measures (SAP BW and MSAS
only) Create pre-defined conditions Define optional prompts All objects based on OLAP universes are generated with index awareness. If there are duplicate
values in a hierarchy for an object, index awareness eliminates inconsistency in the list of values. For example, say that Paris occurs twice in the hierarchy,
once under the parent France and once under the parent Texas. If the user selects Paris under France, only rows for Paris, France are returned. The
following Designer features are not supported for OLAP universes: · You cannot set row-level security authorizations in an OLAP universe. 26 Using SAP
BW in Universe Designer Customizing OLAP universes Calculated measures in OLAP universes 5 · · You cannot edit a list of values in an OLAP universe.
You cannot view and edit the universe entity-relationship schema as no schema is generated for OLAP universes. Related Topics · · · Calculated measures in
OLAP universes on page 27 Pre-defined conditions in OLAP universes on page 29 Optional prompts in OLAP universes on page 32 Calculated measures in
OLAP universes You can create calculated measures in the universe to restrict queries. Calculated measures in OLAP universes are like definitions on the
measure object in non-OLAP universes, except that you define the restriction using MDX functions embedded in XML tags rather than using SQL.
Calculated measures are available for these OLAP data sources: · · SAP BW MSAS 2000 and 2005 Calculated measures can be used in filters or the where
clause. Syntax for calculated measure expressions The syntax for a calculated measure consists of calculations embedded in the tags
<EXPRESSION></EXPRESSION>. Designer functions are allowed in calculated measure expressions, such as: · · · · @Select @Prompt @Variable @Where
Note: Expressions for calculated measures cannot include the @Aggregate_Aware function. Constants are allowed in the expression, for example "10" or
"ABC". Calculated measures can reference any OLAP metadata: · measures Using SAP BW in Universe Designer 27 5 Customizing OLAP universes
Calculated measures in OLAP universes · · · dimensions dimension levels MDX expressions The check integrity validates the XML syntax and any of the
Designer functions.
Recommendations for calculated measure expressions Use @Select (Measure name) rather than the measure definition for the following reasons: · · · @Select
is resolved at query time.
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Calculated measures can reference other calculated measures if they are inside a @Select function. The validity of objects inside the @Select function is
checked. Generate and set the index awareness for each object definition. Use a reference to an object or detail whose definition refers to the Technical Name
or Unique Name of the level or attribute.
Example: Calculated measure expression <EXPRESSION>@Select(Key Figures\Order Amount)*@Select(Key Figures\Order Quantity)</EXPRESSION>
Related Topics · To create a calculated measure in an OLAP universe on page 28 To create a calculated measure in an OLAP universe To create a calculated
measure in an OLAP universe: 1. In Designer, open an OLAP universe. 2. Insert a new measure object in the universe. 3. In the Where: box, enter or paste the
object definition as an XML/MDX expression. 4. Click Parse to review the object definition and fix any errors. 5. Click OK to save the object definition.
6. Select Tools > Check Integrity. 28 Using SAP BW in Universe Designer Customizing OLAP universes Pre-defined conditions in OLAP universes 5 The
integrity check validates the XML syntax and any Designer @FUNCTIONS. Related Topics · Calculated measures in OLAP universes on page 27 Pre-defined
conditions in OLAP universes Pre-defined conditions in OLAP universes are like conditions in non-OLAP universes except that you define the WHERE clause
using XML rather than SQL. Syntax for pre-defined conditions A single pre-defined condition may contain multiple filters combined with the AND and OR
operators. By default, all filters are combined with the AND operator. To include filters using OR, you must use the AND and OR operator tags. The functions
@Select, @Prompt and @Variable are allowed in the pre-defined filter definition. Pre-defined filters can include one or multiple prompts. Prompts can be
mandatory or optional.
Example: Using AND and OR tags for pre-defined conditions <OPERATOR VALUE= ?AND ?> <FILTER "[Level Object definition] ?> <CONDITION
OPERATORCONDITION= ?Operator ?> <CONSTANT Level Attribute= ?Value ?> </CONSTANT> </CONDITION> </FILTER> <OPERATOR VALUE=
?OR ?> <FILTER "[Level Object definition] ?> <CONDITION OPERATORCONDITION= ?Operator ?> <CONSTANT Level Attribute= ?Value
?></CONSTANT> </CONDITION> </FILTER> <FILTER "[Level Object definition] ?> <CONDITION OPERATORCONDITION= ?Operator ?> Using
SAP BW in Universe Designer 29 5 Customizing OLAP universes Pre-defined conditions in OLAP universes <CONSTANT Level Attribute= ?Value
?></CONSTANT> </CONDITION> </FILTER> </OPERATOR> </OPERATOR> Related Topics · · To create pre-defined conditions in an OLAP universe
on page 30 Optional prompts in OLAP universes on page 32 To create pre-defined conditions in an OLAP universe To create a pre-defined condition: 1. In
Designer, open an OLAP universe and click the conditions radio button at the bottom of the Universe pane. The conditions view of the Universe pane appears.
It contains a tree view of the classes in the universe. 2.
Right click a class and select Condition... from the contextual menu. 3.
In the Where: box, edit the XML template filter. The template filter has the format: <FILTER "[Level Object definition] ?> <CONDITION
OPERATORCONDITION= ?Operator ?> <CONSTANT Level Attribute= ?Value ?></CONSTANT> [<CONSTANT></CONSTANT> ...] </CONDITION>
</FILTER> Replace the elements in the template as follows: 30 Using SAP BW in Universe Designer Customizing OLAP universes Pre-defined conditions in
OLAP universes 5 Template element: Level Object definition Operator Possible Values: Enter the dimension level or measure implied in the filter. Enter the
object definition not the object name. Enter one of: · · · · · · · · · · · · Equal Not Equal Greater than Less than Greater than or equal to Less than or equal to
Between Not Between In List Not in List Matches pattern Different from pattern Level Attribute Enter one of: · · · · NAME CAPTION TECH_NAME
DESCRIPTION Value Enter the value or a prompt. Define one value per CONSTANT tag. An example of an edited pre-defined condition: <FILTER
KEY="[0D_DIV].[LEVEL01]"> <CONDITION OPERATORCONDITION="InList"> <CONSTANT CAPTION="Internal"/> <CONSTANT
CAPTION="Service"/> </CONDITION> </FILTER> 4.
Click Parse to review the syntax and fix any errors. Using SAP BW in Universe Designer 31 5 Customizing OLAP universes Optional prompts in OLAP
universes 5. Click OK to save the condition. Related Topics · · Pre-defined conditions in OLAP universes on page 29 Optional prompts in OLAP universes on
page 32 Optional prompts in OLAP universes Universes generated from OLAP data sources support optional prompts. For SAP BW optional variables, filters
with the optional conditions are automatically generated in the universe. In pre-defined conditions or in an object's WHERE clause, to make a prompt
optional, embed the XML filter expression between the two XML tags: <OPTIONAL> and </OPTIONAL>. Example: Optional prompt in a pre-defined
condition <OPTIONAL> <FILTER KEY="[Products].[Family]" > <CONDITION OPERATORCONDITION="InList" > <CONSTANT
CAPTION="Accessories" </CONDITION> </FILTER> </OPTIONAL> Related Topics · To create pre-defined conditions in an OLAP universe on page 30
To improve performance of certain queries on SAP BW universes For queries on SAP BW universes that include only the key and medium name detail objects
of a dimension, you can modify the generated syntax of the objects to improve query performance. To modify the syntax: 1. Open the universe in Designer.
32 Using SAP BW in Universe Designer Customizing OLAP universes To improve performance of certain queries on SAP BW universes 5 2. Double click the
key detail object you want to modify. 3. In the Select text box on the "Definition" tab of the "Edit Properties" dialog box, change the syntax to refer to the
NAME attribute of the SAP characteristic. For example, for the object L01 Customer Key, change the generated select syntax: [Z_CUSTOM].
[LEVEL01].[[2Z_CUSTOM]].[Value] to refer to the NAME attribute: [Z_CUSTOM].[LEVEL01].[NAME] 4.
Click OK to save the changes. 5. Follow the same steps for the name object. Change the syntax to refer to the DESCRIPTION attribute of the SAP
characteristic. For example, for the object L01 Customer Medium Name, change the generated select syntax: [Z_CUSTOM].
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[LEVEL01].[[5Z_CUSTOM]].[Value] to refer to the DESCRIPTION attribute: [Z_CUSTOM].[LEVEL01].[DESCRIPTION] Using SAP BW in Universe
Designer 33 5 Customizing OLAP universes To improve performance of certain queries on SAP BW universes 34 Using SAP BW in Universe Designer OLAP
universe lifecycle management 6 6 OLAP universe lifecycle management To refresh an OLAP universe OLAP universes are generated automatically from an
OLAP data source (for example, an SAP BW Query or MSAS 2005 cube).
In Designer, you can create and change objects in the previously-generated OLAP universe. The Update OLAP Universe Wizard allows you to refresh to
structure of OLAP universes automatically with changes made in the OLAP data source. The wizard can differentiate generated objects from objects added or
modified manually, allowing you to preserve the manual changes made in Designer. The wizard does not update objects added manually in Designer. The
Update OLAP Universe Wizard compares the universe with the updated data source. It detects and updates: · · · · · · · New, modified, and deleted dimensions
New (SAP BW and MSAS only), modified, and deleted hierarchies New, modified, and deleted levels New, modified, and deleted level properties (MSAS only)
New, modified, and deleted measures New, modified, and deleted SAP BW variables New, modified, and deleted sub-classes Related Topics · · To refresh an
OLAP universe on page 36 Designer features supported for OLAP universes on page 26 To refresh an OLAP universe To refresh the structure of an OLAP
universe: 1. In Designer, open the universe you want to update. 2. Select View > Refresh Structure. The Update OLAP Universe wizard appears.
3. Click Begin. The "Universe Update Option" page appears. Select keep options when you want to preserve modifications to objects in the universe that were
made manually. All keep options are selected by default.
@@Hide is selected by default. @@@@Select the desired options and click Finish. @@@@5. @@@@Click Check Integrity to perform an integrity check.
@@When the check is complete, the Integrity Check Results page appears.
@@@@@@@@@@@@@@@@@@However, the filtering applies to the universe. @@@@@@@@@@The SELECT clause is defined using the
technical name of the characteristic. Navigation attributes defined in the BW Query are mapped in the parent object class in the same way as characteristics
are mapped. Note: A large number of navigation attributes defined in the universe negatively impacts the performance of the query in Web Intelligence.
Stuctures defined in the BW Query that are based on characteristics are included in the universe as single-dimension objects with the elements of the structure
as dimension members. 42 Using SAP BW in Universe Designer How SAP BW objects are mapped and used in a universe How SAP BW key figures are
mapped and used in a universe 7 How SAP BW key figures are mapped and used in a universe All key figures in the InfoCube or defined in the BW Query are
included in the universe under a single object class called "Key Figures ?. Most key figures are defined in BW with either a currency or a unit characteristic.
For each key figure, Designer creates: · · · A measure object with numeric format corresponding to the key figure without the unit. A dimension object with
character format that contains the unit or currency. For example, 'USD', '', 'km'.
A dimension object with character format that contains the key figure and the unit (formatted value) based on user preferences configured on the SAP server.
For example, '200 USD', '345 ', '25 km'. The Key Figures class includes the calculated key figures and restricted key figures defined in the BW Query. The
original calculation and restrictions are applied to the query, but are not exposed in the universe. How SAP BW hierarchies are mapped and used in a
universe Hierarchies are mapped to allow Web Intelligence users to drill down with SAP BW hierarchies in the same way as custom-made universe
hierarchies. Note: The Use Query Drill option in the Web Intelligence Document Properties dialog box significantly improves drill down performance. When
a hierarchy is defined on a characteristic in the BW Query, Designer creates one hierarchical structure in the universe, with a subclass for each level in the
hierarchy. The structure depends on the current BW Query definition: · · If a hierarchy is defined in the BW Query, Designer creates this hierarchy structure
in the universe. If a hierarchy variable is defined in the BW Query that allows the user to choose a hierarchy at run time, Designer creates a generic
hierarchy in Using SAP BW in Universe Designer 43 7 How SAP BW objects are mapped and used in a universe How SAP BW variables are mapped and
used in a universe the universe. The structure has the highest number of levels defined for any of the hierarchy structures available for the characteristic.
When building a universe on top of an InfoCube, all hierarchies defined on the characteristic are exposed in the resulting universe. Designer creates
subclasses for each hierarchical structure, each containing subclasses for the levels in that hierarchy. In the universe, Level 00 of a hierarchy represents the
top node of the structure. When multiple tops exist for the hierarchical structure, the Level 00 dimension contains all top nodes as a list of values. When the
hierarchy attribute is set to not filter unassigned nodes, it is necessary to include Level 00 with the top node for unassigned members.
Unassigned members are grouped at the lowest level of the hierarchy. Note: Most often BW hierarchies have only one top node. You can delete the Level 00
objects from the default universe to make the universe simpler to use. Generally, you only need to keep Level 00 when there is a need to query/report
unassigned members. If the number of levels in a hierarchy changes in the BW query, you must update the universe.
Related Topics · OLAP universe lifecycle management on page 35 How SAP BW variables are mapped and used in a universe SAP BW variables supported in
universes SAP variables can be interpreted as user prompts defined in the BW Query. Variables can be mandatory or optional, and can have default values.
Variables for characteristics are used to filter values for a characteristic. Variables are populated with values when a query is executed. They can store
characteristic values, hierarchies, hierarchy nodes, texts, and formula elements. 44 Using SAP BW in Universe Designer How SAP BW objects are mapped
and used in a universe How SAP BW variables are mapped and used in a universe 7 BW variables apply to BW Queries only. Note: Only BW variables
defined as 'Ready for Input' are processed. When defining the variable in the SAP BW Query Designer, on the SAP BW Variables Wizard Other Settings
dialog box, the Ready for Input option must be selected.
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The following types of SAP BW variables are supported in universes: · · · · · · · Characteristic variables Hierarchy variables Hierarchy node variables
Currency variables Formula variables Text variables (as replacement path and authorization processed variables) Key date variables The following table
shows universe support for user entry SAP BW variables. User entry variables can be mandatory or optional, and can have default values.
Variable Type single value prompt Support Level supported multiple single value supported Characteristic prompt (including (key date and curren- interval
prompt supported cy) selection option prompt supported as interval prompt pre-calculated value set not supported Text Formula not supported price, quota,
and numeric values supported supported except for version variable Hierarchy Using SAP BW in Universe Designer 45 7 How SAP BW objects are mapped
and used in a universe How SAP BW variables are mapped and used in a universe Variable Type Hierarchy node Support Level supported The following
table shows universe support for other processing types of SAP BW variables. Processing Type Variable type Replacement path Authorization Customer
exSAP exit it supported without user entry N/A supported without user entry supported without user entry supported without user entry supported without user
entry supported without user entry N/A supported without user entry supported without user entry supported without user entry supported without user entry
Characteristic supported supported Text supported N/A Formula supported N/A Hierarchy supported N/A Hierarchy node N/A N/A N/A supported The
Exclude operator is supported, however Web Intelligence does not specify that the selected value be excluded from the query. Other operators, such as Less
than and Greater than, can only be used with Selection option entry type. The selection option type is turned into an interval for Web Intelligence prompting.
46 Using SAP BW in Universe Designer How SAP BW objects are mapped and used in a universe How SAP BW variables are mapped and used in a universe
7 Note: To process BW variables in Web Intelligence, you must include at least one measure in the Web Intelligence query. Related Topics · · · · SAP BW
variable mapping to a universe on page 47 Mandatory filters and list of values on page 50 SAP BW key date variables in a universe on page 52 SAP BW
hierarchy and hierarchy node variables in a universe on page 53 SAP BW variable mapping to a universe The user needs to be prompted for all optional and
mandatory variables, even when the dimension is not used in the result set, allowing the user to limit the result set. Threfore, a variable defined in the BW
Query is mapped, even if the corresponding characteristic is not in the query. The user needs to know if a variable is mandatory or optional, and be able to
ignore optional variables. Optional variables are defined as optional in the universe, and become optional prompts in Web Intelligence. Mandatory variables
become mandatory prompts in Web Intelligence.
For characteristic variables, Designer creates a mandatory filter in the universe. A mandatory filter is a pre-defined query filter object which is hidden to
Web Intelliegence users, but is applied systematically and transparently to all Web Intelligence queries built on the universe. Variable Type Characteristic
variable, including currency and formula variable Hierarchy variable Hierarchy node variable Key date variable Mapped to Universe mandatory filter
Universe mandatory filter Class mandatory filter Universe parameters Using SAP BW in Universe Designer 47 7 How SAP BW objects are mapped and used
in a universe How SAP BW variables are mapped and used in a universe For each mandatory filter, two dimension objects are created as reference objects
for the @Prompt function to display the expected list of values. The list of values dimensions are hidden in the universe. They are necessary for the correct
functioning of the prompt so must not be deleted and must be moved or modified carefully.
Default values for variables are defined in the @Prompt function in the filter using the primary key, persistent/not persistent, and default values parameters.
The @Prompt function syntax can be seen in the Properties page of the filter in the universe. To avoid conflict between SAP BW variables and filters defined
by Web Intelligence users, objects involved in an SAP variable definition are generated with the option Can be used in Condition unchecked in the Advanced
page of the object properties. This restricts Web Intelligence users from including dimensions involved in SAP variables in the Filter pane. Example: WHERE
clause generated for an SAP BW variable This example shows the WHERE clause generated for a BW variable on dimension object Customer2.
The syntax for the generated WHERE clause for a variable can be seen on the Properites page of the filter. <FILTER KEY="[Z_VAR002]"> <CONDITION
OPERATORCONDITION="Equal"> <CONSTANT TECH_NAME="@Prompt( 'Customer Variable Single Value Mandatory', 'A', 'Customer2\LovCustomer
Variable Single Value MandatoryBase', mono, primary_key)"/> <CONDITION> </FILTER> The prompt text is generated from the BW variable name. You
can edit the text to make it more descriptive. Customer2\LovCustomer Variable Single Value MandatoryBase is the name of the hidden universe object that is
used to build the list of values. Note: If you rename the class or move the list of values object to another folder, you must update the syntax in the filter key. 48
Using SAP BW in Universe Designer How SAP BW objects are mapped and used in a universe How SAP BW variables are mapped and used in a universe 7
Related Topics · Mandatory Filters on page 49 Mandatory Filters There are two types of mandatory filter: · Universe: A universe mandatory filter has no
dependency on the class to which it belongs. A universe mandatory filter is included in the query independently of the objects (dimensions, measures, and
details) that are included in the query. Most SAP BW variables are created as universe mandatory filters when generating OLAP universes on SAP BW. ·
Class: Class mandatory filters appear only if an item of the class of the object is used in the query. A class mandatory filter is triggered when users: · · Add an
object (dimension, measure, or detail) to the "Result" pane of the "Query Panel" in Web Intelligence.
Add a universe pre-defined filter to the "Filter" pane of the "Query panel", even if no object that belongs to the same class has been selected in the Result
pane. Create a filter with an object (dimension, measure, or detail) that belongs to a class with a mandatory filter.
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· A mandatory filter can have default values or be associated with a list of values. A mandatory filter is hidden and cannot be selected in the "Query Panel"
in Web Intelligence. In Designer, when you set a filter as mandatory in the query, then it is hidden automatically and the Show Item(s) command is disabled. If
you uncheck the mandatory option, the filter is no longer hidden. The Hide Item(s) command is enabled. An end-user query can include more than one
mandatory filter. By default, all mandatory filters are joined in the query with the AND operator. All sub-classes inherit the mandatory filters from the parent
class.
Note, however: Using SAP BW in Universe Designer 49 7 How SAP BW objects are mapped and used in a universe How SAP BW variables are mapped and
used in a universe · · · An object (dimension, measure, detail) that references another object with the @Select function does not inherit the class mandatory
filter of the referenced object. A WHERE clause of an object that references another object where clause with the @Where function does not inherit the class
mandatory filter of the referenced object. A pre-defined filter that references another pre-defined filter or an object where clause with the @Where function
does not inherit the class mandatory filter of the referenced object. Example: Mandatory filter in an OLAP universe The following filter (shown in XML code)
authenticates the code entered by a user in a prompt. <FILTER KEY="[BCOMUSI]"> <CONDITION OPERATORCONDITION="InList"> <CONSTANT
TECH_NAME= "@Prompt('CO_CODE Char User MultiSingle Man Def', 'A','Company code\Lov[BCOMUSI]Base', multi,primary_key)"/> </CONDITION>
</FILTER> Related Topics · Mandatory filters and list of values on page 50 Mandatory filters and list of values Mandatory filters can be associated with a
list of values.
To associate a list of values, you must explicitly select the list of value options in the object properties page of the object to which the filter applies. A universe
mandatory filter can be associated with a cascading list of values. A class mandatory filter can be associated with a cascading list of values if at least one
object in the corresponding class is part of the cascading list of values. This is true even if the cascading list of values groups objects from different classes.
50 Using SAP BW in Universe Designer How SAP BW objects are mapped and used in a universe How SAP BW variables are mapped and used in a universe
7 Recommendations Generate mandatory filters only on the top level of a cascading list of values.
Do not associate a cascading list of values with a mandatory filter that contains a prompt. Web Intelligence does not support prompts in cascading lists of
values. SAP BW variables and list of values An SAP BW Query can contain more than ten variables, which means that ten or more lists of values can be
loaded. Loading and refreshing lists of values can have an important impact on performance. The following options are available for improving query
performance for queries with variables: · At universe generation time, all SAP BW variables (except key date) are mapped to mandatory filters. By default, the
filter objects are not associated with a list of values (except for hierarchy node variables). You must explicitly associate a list of values in the object properties
page. Optional variables are generated as optional prompts. An optional prompt does not automatically load the list of values at query run time. The delegate
search option on the list of values properties presents the user with an empty list of values at query run time.
The user enters search criteria to limit the number of values returned in the list of values. To activate the delegated search option for a list of values, edit the
list of values properties on the object properties page of the object to which the list of values applies. Note: · · The delegated search is not supported for
cascading lists of values. Related Topics · · Optional prompts in OLAP universes on page 32 Mandatory filters and list of values on page 50 Using SAP BW in
Universe Designer 51 7 How SAP BW objects are mapped and used in a universe How SAP BW variables are mapped and used in a universe SAP BW key
date variables in a universe A key date variable in a BW Query allows you to specify a date for time-dependent data. Key dates can influence the data
retrieved for a dimension, for example, a product description can change over time. A key date can influence a hierarchy structure, for example, a specific
cost center can be on Level 01 in one year, and on Level 02 in a different year. The key date variable is a special SAP BW variable because the date value
entered by the user is not contained in any dimension of the BW Query. The key date is a property of the query. In a BW Query, the key date variable can be
defined for two uses: · · To specify the valid date for a specific hierarchy, impacting only that hierarchy. To specify a date for the complete query.
In this case, the key date that is set in a query influences the following: · time-dependent master data · currency exchange rates · the list of hierarchies · timedependent hierarchy structures Note: In the universe, the use of a key date is limited to the whole universe. Therefore, the key date generated in a universe
impacts all other SAP variables and data. SAP BW supports only one key date variable per BW Query, therefore a universe contains only one key date
variable. Key date variables can be mandatory or optional, and can have a default value. If no default value is defined and the user does not enter a value, the
query uses the current system date.
@@Technical name of the key date variable. @@Default value for the key date, if it exists. @@The user can modify the key date. @@The user is prompted
for the key date before any other type of variable prompt. SAP BW hierarchy and hierarchy node variables in a universe A hierarchy variable is used to
prompt the user for the hierarchy to be used in the query.
Web Intelligence users can create queries and reports to retrieve and display members from any hierarchy. If the hierarchy variable is optional and the user
leaves the prompt empty, no hierarchy is used in the report. A report contains the largest number of hierarchy levels independent of the hierarchy that is
selected. Hierarchy levels that are not returned in the result set are empty in the report. A hierarchy node variable is used to prompt the user for the node to
be defined as top node for the hierarchy in the query. Using SAP BW in Universe Designer 53 7 How SAP BW objects are mapped and used in a universe
How SAP BW variables are mapped and used in a universe When a query contains both a hierarchy and hierarchy node variable, the Web Intelligence user
must first select a hierarchy in the list of available hierarchies.
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Next, the user selects the hierarchy node. The list of hierarchy nodes available shows hierarchy nodes for all hierarchies. The list is not filtered based on the
hierarchy selected. The user is responsible for selecting a node from the correct hierarchy.
Selecting a hierarchy node from a different hierarchy can cause the report to be empty. Related Topics · How SAP BW hierarchies are mapped and used in a
universe on page 43 54 Using SAP BW in Universe Designer Get More Help A A Get More Help Online documentation library Business Objects offers a full
documentation set covering all products and their deployment. The online documentation library has the most up-to-date version of the Business Objects
product documentation. You can browse the library contents, do full-text searches, read guides on line, and download PDF versions. The library is updated
regularly with new content as it becomes available. To access the online documentation library, visit http://help.sap.com/ and click Business Objects at the top
of the page. Additional developer resources https://boc.sdn.
sap.com/developer/library/ Online customer support The Business Objects Customer Support web site contains information about Customer Support
programs and services. It also has links to a wide range of technical information including knowledgebase articles, downloads, and support forums.
http://www.businessobjects.
com/support/ Looking for the best deployment solution for your company? Business Objects consultants can accompany you from the initial analysis stage to
the delivery of your deployment project. Expertise is available in relational and multidimensional databases, in connectivities, database design tools,
customized embedding technology, and more. For more information, contact your local sales office, or contact us at:
http://www.businessobjects.com/services/consulting/ Looking for training options? From traditional classroom learning to targeted e-learning seminars, we
can offer a training package to suit your learning needs and preferred learning style.
Find more information on the Business Objects Education web site: http://www.businessobjects.com/services/training 56 Using SAP BW in Universe Designer
Get More Help A Send us your feedback Do you have a suggestion on how we can improve our documentation? Is there something you particularly like or
have found useful? Drop us a line, and we will do our best to ensure that your suggestion is included in the next release of our documentation:
mailto:documentation@businessobjects.com Note: If your issue concerns a Business Objects product and not the documentation, please contact our Customer
Support experts. For information about Customer Support visit: http://www.businessobjects.com/support/. Business Objects product information For
information about the full range of Business Objects products, visit: http://www.businessobjects.com.
Using SAP BW in Universe Designer 57 A Get More Help 58 Using SAP BW in Universe Designer Index A authentication SAP BW connections 18 H
hierarchy mapping in OLAP universe (SAP BW) 43 variables (SAP BW) 53 C calculated measure in OLAP universe 27 characteristics mapping in OLAP
universe 42 classes and objects mapping in OLAP universe (SAP BW) 40 modifying in OLAP universes 26 condition object defining in OLAP universe 29
mandatory in query 49 connection defining 16 I index awareness in OLAP universes 26 K key date variables in OLAP universes 52 key figures mapping in
OLAP universe 43 L list of values and SAP BW variables 51 D define condition object in OLAP universe 29 connection to database 16 M mandatory filter
defining 49 list of values 50 variables (SAP BW) 47 measure calculated 27 multilingual universes SAP BW 13 F filter mandatory in query 49 Using SAP BW
in Universe Designer 59 Index O OLAP universes mapping SAP BW objects 40 modifying 26 optional prompt in OLAP universe 32 SAP BW (continued)
features supported in universe 12 mapping to OLAP universe 40 multilingual universes 13 Single Sign On (SSO) SAP BW 8 P prompt optional (OLAP
universe) 32 U universe refresh OLAP 36 update OLAP 36 universe lifecycle (OLAP) 36 update OLAP universe 36 R refresh OLAP universe 36 V variables in
OLAP universe (SAP BW) 44 S SAP BW data sources for OLAP universe 10 60 Using SAP BW in Universe Designer .
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